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Préface
Ce document s'adresse aux contributeurs (nombreux, espérons le..) qui auront à participer à l'amélioration
de la documentation JOnAS.

Il est fortement conseiller de le lire avant de contribuer car l'infrastructure de fabrication de la documen-
tation a complètement changé par rapport à l'ancienne documentation JOnAS. Avant il fallait écrire direc-
tement la documentation en HTML.

Maintenant, la technologie utilisée est XML DocBook qui a l'avantage de bien séparer la partie contenu
de la présentation et de permettre de générer cette documentation sous différents formats.

Ce document est censé décrire comment écrire, fabriquer, publier la documentation JOnAS.

Nous avons profiter de ce changement pour intégrer la documentation dans SVN.

Le but du jeu est de faire passer petit à petit la documentation actuelle dans ce format.

Le document est organisé de la manière suivante:

Chapitre 1 , L'infrastructure de documentation JOnAS décrit la structure du projet SVN aussi bien du
point de vue des fichiers initiaux (DocBook, feuilles de style) que des fichiers générés (HTML,pdf,war)

Chapitre 2, L'outillage de développement décrit brièvement l'utilisation d'un outil possible et conseillé
pour écrire la doc en DocBook

Chapitre 3, Apprendre à maitriser DocBook, n'est pas un manuel de référence mais c'est un chapitre
qui donne des liens sur des documents intéressants sur DocBook, et des solutions à quelques problèmes.
Ce chapitre devrait être en constante évolution pour constituer une base de connaissance.

Chapitre 4, Conventions et règles diverses, se veut une collection de bonnes pratiques dont le but pricipal
est d'obtenir une documentation homogène quelque soit le nombre de rédacteurs.

Les trois premiers chapitres sont spécifiques à la documentation JOnAS les trois autres peuvent être utilisés
dans un autre contexte.

Last but not least, comme vous le voyez ce document est écrit en français contrairement a reste de la
documentation JOnAS qui est écrite prioritairement en anglais. Il devra être traduit à terme.
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Chapitre 1. L'infrastructure de
documentation JOnAS
1.1. Description

La documentation JOnAS compose un nouveau module SVN jonas_doc du repository jonas4. Il apparaît
pour la première fois dans la branche jonas_4_8.

Dans ce projet jonas_doc va être mis en oeuvre le DocBook Xslt Publishing Model qui est décrit dans ce
diagramme [http://wiki.docbook.org/topic/DocBookXsltPublishingModelDiagram]

1.1.1. Structure du module SVN jonas_doc
Le module SVN jonas_doc a la structure suivante:

Avec:

olddoc contient les fichiers html correspondant à l'ancienne doc JOnAS

src/docbook/doc-en contient les fichiers xml correspondants aux documents anglais écrits en doc-
Book

src/docbook/doc-fr contient les fichiers xml correspondants aux documents français écrits en
docBook

resources contients les images, les stylesheets xls ou css

tools contient le processeur Apache FOP utilisé pour fabriquer les documents pdf.

1.2. Générer la doc JOnAS via ant
La génération de la doc se fait via ant en général sous eclipse (build.xml). Il existe une target par guide:

url(http://wiki.docbook.org/topic/DocBookXsltPublishingModelDiagram)
url(http://wiki.docbook.org/topic/DocBookXsltPublishingModelDiagram)


L'infrastructure de documentation JOnAS

2

target description état de la doc

configguide permet de générer le configuration
guide

relue par l'équipe JOnAS

commandguide génération du command référence
guide

écrite, à relire

adminguide génération de l'administration
guide

à écrire

guides génération des différents guides n/a

howto génération du JOnAS Documenta-
tion How To (c'est à dire ce docu-
ment)

en constante évolution

dist génération de la doc avec prise en
compte de l'ancienne doc non en-
core réécrite

n/a

war permet de refabriquer le war jo-
nas-doc-en.war pour JOnAS

n/a

Pour chaque guide il est possible de générer :

• un document html unique via la target transform1html

• un document partitonné en chunk  via la target transformchunkhtml

• les précédents documents avec le look du site JOnAS via la target integrated

• un document en format XSL-FO1 (formatting object) via la target transform1fo

• un document pdf à partir du document XSL-FO via la target pdf

Les targets transform1html et transformchunkhtml s'expriment en terme de la target transform qui par
défaut utilise xalan. Mais comme xalan ne sait pas traiter correctement les directives xi:include utilisées

pour faire l'inclusion de documents xml un préprocessing est nécéssaire avec la commande xmllint.2

la target transform1 est équivalente à transform mais utilise xlstproc.

Les transformations XML docBook -> HTML se fait via les feuilles de styles html.xsl et chunk.xsl

la transformation XML-> XSL-FO se fait via la feuille de style fo.xls

Ces feuilles de style se trouvent dans la directory resources

Attention

ces feuilles de styles incluent d'autres que l'on considère se trouver sous /usr/share/xml/
docbook/stylesheet/nwalsh/html/docbook.xsl ce qui est une adhérence à notre environne-
ment.

1.3. Structure de la doc générée via ant:
1. Génération des guides (target guides):

2Il est peut être possible de traiter es directives xi:include via xalan à voir!
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L'ensemble des fichiers résultants de la génération de la documentation se trouve dans la directory
output/generation du projet eclipse jonasdocbook. Voici la structure d'ouput:

Pour chacun des guides il y a 6 directories:

• chunk où se trouve le document ségmentés en chunks

• chunk-integrated: le même que précédemment mais intégré au site JOnAS

• fo: se trouve le document sous forme XSL-FO

• html: où se trouve le document sous forme d'un fichier html monolithique

• integrated: le même que précédemment mais intégré au site JOnAS

• pdf: le document en format pdf.

2. Génération du jonas-doc-en.war pour JOnAS (target war)

la target dist récupère les documents

• html sous dist/integrated (ancienne doc comprise)

• pdf sous dist/pdf

la target war contruit jonas-doc-en.war sous dist/war (la tagerget war depend
de dist).
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1.4. Structure de la doc sur le site JOnAS:
Deux machines rentrent en ligne de compte jonas.forge.objectweb.org et jonas.objectweb.org

Sur ces deux machines la structure est identique:

• dans la directory current :

• doc la doc html générée (structure identique à output/dist/integrated)

• jdoc la javadoc générée

• dans la directory doc:

• howto : encore les howto! pourquoi?....

• jonas-dox [http://jonas.objectweb.org/doc/jonas-dox/] : doc générée par dowygen sur JOnAS 4.4.0 !!

• tutorial  [http://jonas.objectweb.org/doc/tutorial/src/html/index.html]: un tutorial JOnAS 3.3

• tutorial_old [http://jonas.objectweb.org/doc/tutorial_old/html/index.html] :un tutorial JOnAS 2.4

• tutorial_portug [http://jonas.objectweb.org/doc/tutorial_portug/tutorialJOnAS/index.html] : un mi-
ni tutorial JOnAS 3.3 en portugais

• un ensemble de documents en pdf dont ceux correspondants au guides écrits en DocBook:

• configuration guide [http://jonas.objectweb.org/doc/configuration_guide.pdf]

• commands reference guide [http://jonas.objectweb.org/doc/command_guide.pdf]

1.5. Publier la doc sur le site JOnAS
La publication de la doc se fait en deux phases:

1. Mise à jour de jonas.forge.objectweb.org pour cela il faut utiliser (sur linux) le gestionnaire de fichiers
nautilus:

• se positionner sur la machine locale sur<directory_projet_jonasdocbook>/output/
dist/doc-en

• sélectionner l'ensemble des fichiers (Ctrll A)

• faire Edit>Copy

• se connecter sur la machine distante jonas.forge.objectweb.org sur la directory /current/doc:

Faire File>Connect to Server il apparait une fenêtre du style

url(http://jonas.objectweb.org/doc/jonas-dox/)
url(http://jonas.objectweb.org/doc/jonas-dox/)
url(http://jonas.objectweb.org/doc/tutorial/src/html/index.html)
url(http://jonas.objectweb.org/doc/tutorial/src/html/index.html)
url(http://jonas.objectweb.org/doc/tutorial_old/html/index.html)
url(http://jonas.objectweb.org/doc/tutorial_old/html/index.html)
url(http://jonas.objectweb.org/doc/tutorial_portug/tutorialJOnAS/index.html)
url(http://jonas.objectweb.org/doc/tutorial_portug/tutorialJOnAS/index.html)
url(http://jonas.objectweb.org/doc/configuration_guide.pdf)
url(http://jonas.objectweb.org/doc/configuration_guide.pdf)
url(http://jonas.objectweb.org/doc/command_guide.pdf)
url(http://jonas.objectweb.org/doc/command_guide.pdf)
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Dans la fenetre qui s'ouvre faire File>Paste

• faire Edit>Copy sur la machine locale sur<directory_projet_jonasdocbook>/output/
dist/resources

• faire File>Paste sur jonas.forge.objectweb.org sur la directory /current/doc:

• refaire l'opération pour le fichier <directory_projet_jonasdocbook>src/resources/index.hml

• se positionner sur la machine locale

sur le directory <directory_projet_jonasdocbook>/output/dist/pdf

• faire Edit>Copy pour tous les documents pdf que l'on veut transférer

• se connecter sur la machine distante jonas.forge.objectweb.org sur la directory /doc

• faire Edit>Paste pour les documents pdf

2. Mise à jour de jonas.objectweb.org :

Se mettre sous l'onglet admin de la forge JOnAS: [http://forge.objectweb.org/project/admin/
?group_id=5]

url(http://forge.objectweb.org/project/admin/?group_id=5)
url(http://forge.objectweb.org/project/admin/?group_id=5)
url(http://forge.objectweb.org/project/admin/?group_id=5)
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Cliquer sur le bouton de publication "Push Project Web Site from Development to Production Now!"
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L'opération est souvent longue et on obtient une page web ressemblant à ça:

Results of your command:

At revision 10320.
Buildfile: build.xml

clean:
[delete] Deleted 1 directory from /var/www/work/jonas/update.10332/public_html
[delete] Deleted 1 directory from /var/www/work/jonas/update.10332/cgi-bin
[delete] Deleting 38 files from /var/www/work/jonas/web/common
[delete] Deleted 6 directories from /var/www/work/jonas/web/common
[delete] Deleting: /var/www/work/jonas/web/.build

unzip_common_web:
[unzip] Expanding: /var/www/work/jonas/web/common_web.zip into /var/www/work/jonas/web/common

prepare:
[mkdir] Created dir: /var/www/work/jonas/update.10332/public_html
[mkdir] Created dir: /var/www/work/jonas/update.10332/cgi-bin
[copy] Copying 1 file to /var/www/work/jonas/update.10332/public_html
[copy] Copying 30 files to /var/www/work/jonas/update.10332/public_html/images
[copy] Copying 220 files to /var/www/work/jonas/update.10332/public_html
[copy] Copying 1 file to /var/www/work/jonas/update.10332/public_html/js
[copy] Copying 2 files to /var/www/work/jonas/update.10332/cgi-bin

check:
[xmlvalidate] 20 file(s) have been successfully validated.

html_print:

real_html:
[style] Transforming into /var/www/work/jonas/update.10332/public_html
[style] Processing /var/www/work/jonas/web/xml/root/contacts.xml to /var/www/work/jonas/update.10332/public_html/contacts_print.html
[style] Loading stylesheet /var/www/work/jonas/web/common/stylesheets/printable.xsl
[style] Processing /var/www/work/jonas/web/xml/root/contrib.xml to /var/www/work/jonas/update.10332/public_html/contrib_print.html
[style] Processing /var/www/work/jonas/web/xml/root/doc/index.xml to /var/www/work/jonas/update.10332/public_html/doc/index_print.html
[style] Processing /var/www/work/jonas/web/xml/root/download/index.xml to /var/www/work/jonas/update.10332/public_html/download/index_print.html
[style] Processing /var/www/work/jonas/web/xml/root/form.xml to /var/www/work/jonas/update.10332/public_html/form_print.html
[style] Processing /var/www/work/jonas/web/xml/root/history.xml to /var/www/work/jonas/update.10332/public_html/history_print.html
[style] Processing /var/www/work/jonas/web/xml/root/index_old.xml to /var/www/work/jonas/update.10332/public_html/index_old_print.html
[style] Processing /var/www/work/jonas/web/xml/root/license.xml to /var/www/work/jonas/update.10332/public_html/license_print.html
[style] Processing /var/www/work/jonas/web/xml/root/partners.xml to /var/www/work/jonas/update.10332/public_html/partners_print.html
[style] Processing /var/www/work/jonas/web/xml/root/prototypes.xml to /var/www/work/jonas/update.10332/public_html/prototypes_print.html
[style] Processing /var/www/work/jonas/web/xml/root/releaserules.xml to /var/www/work/jonas/update.10332/public_html/releaserules_print.html
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[style] Processing /var/www/work/jonas/web/xml/root/success.xml to /var/www/work/jonas/update.10332/public_html/success_print.html
[style] Processing /var/www/work/jonas/web/xml/root/support.xml to /var/www/work/jonas/update.10332/public_html/support_print.html
[style] Processing /var/www/work/jonas/web/xml/root/team.xml to /var/www/work/jonas/update.10332/public_html/team_print.html
[style] Processing /var/www/work/jonas/web/xml/root/tests.xml to /var/www/work/jonas/update.10332/public_html/tests_print.html
[style] Processing /var/www/work/jonas/web/xml/root/thanks.xml to /var/www/work/jonas/update.10332/public_html/thanks_print.html
[style] Processing /var/www/work/jonas/web/xml/root/tools.xml to /var/www/work/jonas/update.10332/public_html/tools_print.html
[style] Processing /var/www/work/jonas/web/xml/root/voteform.xml to /var/www/work/jonas/update.10332/public_html/voteform_print.html
[style] Processing /var/www/work/jonas/web/xml/root/workplan.xml to /var/www/work/jonas/update.10332/public_html/workplan_print.html

html:

real_html:
[style] Transforming into /var/www/work/jonas/update.10332/public_html
[style] Processing /var/www/work/jonas/web/xml/root/contacts.xml to /var/www/work/jonas/update.10332/public_html/contacts.html
[style] Loading stylesheet /var/www/work/jonas/web/common/stylesheets/browsable.xsl
[style] Processing /var/www/work/jonas/web/xml/root/contrib.xml to /var/www/work/jonas/update.10332/public_html/contrib.html
[style] Processing /var/www/work/jonas/web/xml/root/doc/index.xml to /var/www/work/jonas/update.10332/public_html/doc/index.html
[style] Processing /var/www/work/jonas/web/xml/root/download/index.xml to /var/www/work/jonas/update.10332/public_html/download/index.html
[style] Processing /var/www/work/jonas/web/xml/root/form.xml to /var/www/work/jonas/update.10332/public_html/form.html
[style] Processing /var/www/work/jonas/web/xml/root/history.xml to /var/www/work/jonas/update.10332/public_html/history.html
[style] Processing /var/www/work/jonas/web/xml/root/index_old.xml to /var/www/work/jonas/update.10332/public_html/index_old.html
[style] Processing /var/www/work/jonas/web/xml/root/license.xml to /var/www/work/jonas/update.10332/public_html/license.html
[style] Processing /var/www/work/jonas/web/xml/root/partners.xml to /var/www/work/jonas/update.10332/public_html/partners.html
[style] Processing /var/www/work/jonas/web/xml/root/prototypes.xml to /var/www/work/jonas/update.10332/public_html/prototypes.html
[style] Processing /var/www/work/jonas/web/xml/root/releaserules.xml to /var/www/work/jonas/update.10332/public_html/releaserules.html
[style] Processing /var/www/work/jonas/web/xml/root/success.xml to /var/www/work/jonas/update.10332/public_html/success.html
[style] Processing /var/www/work/jonas/web/xml/root/support.xml to /var/www/work/jonas/update.10332/public_html/support.html
[style] Processing /var/www/work/jonas/web/xml/root/team.xml to /var/www/work/jonas/update.10332/public_html/team.html
[style] Processing /var/www/work/jonas/web/xml/root/tests.xml to /var/www/work/jonas/update.10332/public_html/tests.html
[style] Processing /var/www/work/jonas/web/xml/root/thanks.xml to /var/www/work/jonas/update.10332/public_html/thanks.html
[style] Processing /var/www/work/jonas/web/xml/root/tools.xml to /var/www/work/jonas/update.10332/public_html/tools.html
[style] Processing /var/www/work/jonas/web/xml/root/voteform.xml to /var/www/work/jonas/update.10332/public_html/voteform.html
[style] Processing /var/www/work/jonas/web/xml/root/workplan.xml to /var/www/work/jonas/update.10332/public_html/workplan.html

publish:
[touch] Creating /var/www/work/jonas/web/.build

BUILD SUCCESSFUL
Total time: 10 seconds
building file list ... done
./
JonasPublic.htm
common.css
contacts.html
contacts_print.html
contrib.html
contrib_print.html
form.html
form_print.html
history.html
history_print.html
index.htm
index.html
index.php
index_old.html
index_old_print.html
jonasDocumentation.htm
jonasDownload.htm
jonasFormulaire.htm
jonasHistory.htm
jonasHomePage.htm
jonasLicence.htm
jonasNews.htm
jonasOPL1_0.htm
jonasPartners.htm
jonasSuccessStories.htm
jonasToolsIndex.htm
jonasWhitePaper.htm
license.html
license_print.html
partners.html
partners_print.html
prototypes.html
prototypes_print.html
releaserules.html
releaserules_print.html
site_preview.jpg
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success.html
success_print.html
support.html
support_print.html
team.html
team_print.html
tests.html
tests_print.html
thanks.html
thanks_print.html
tools.html
tools_print.html
voteform.html
voteform_print.html
workplan.html
workplan_print.html
current/doc/
current/doc/doc-en/
current/doc/doc-en/integrated/
current/doc/doc-en/integrated/Admin.html
current/doc/doc-en/integrated/Cmi.html
current/doc/doc-en/integrated/Deployer.html
current/doc/doc-en/integrated/Domain.html
current/doc/doc-en/integrated/JOnASWP.html
current/doc/doc-en/integrated/JOnASWebServices.html
current/doc/doc-en/integrated/MBeans.html
current/doc/doc-en/integrated/PG_Client.html
current/doc/doc-en/integrated/PG_Connector.html
current/doc/doc-en/integrated/PG_Deployment.html
current/doc/doc-en/integrated/PG_EarDeployment.html
current/doc/doc-en/integrated/PG_Entity.html
current/doc/doc-en/integrated/PG_Environment.html
current/doc/doc-en/integrated/PG_J2eeApps.html
current/doc/doc-en/integrated/PG_JmsGuide.html
current/doc/doc-en/integrated/PG_LogModules.html
current/doc/doc-en/integrated/PG_MsgDrvBean.html
current/doc/doc-en/integrated/PG_Packaging.html
current/doc/doc-en/integrated/PG_Security.html
current/doc/doc-en/integrated/PG_Session.html
current/doc/doc-en/integrated/PG_Transaction.html
current/doc/doc-en/integrated/PG_War.html
current/doc/doc-en/integrated/Services.html
current/doc/doc-en/integrated/TMF.html
current/doc/doc-en/integrated/ant-ejbjar.html
current/doc/doc-en/integrated/clusterd.html
current/doc/doc-en/integrated/clustering.html
current/doc/doc-en/integrated/command_guide.html
current/doc/doc-en/integrated/common.css
current/doc/doc-en/integrated/configuration_guide.html
current/doc/doc-en/integrated/fdf.html
current/doc/doc-en/integrated/getting_started_guide.html
current/doc/doc-en/integrated/index.html
current/doc/doc-en/integrated/migration_guide.html
current/doc/doc-en/integrated/.DAV/
current/doc/doc-en/integrated/howto/
current/doc/doc-en/integrated/howto/Clustering.html
current/doc/doc-en/integrated/howto/Compile.html
current/doc/doc-en/integrated/howto/Firewall.html
current/doc/doc-en/integrated/howto/InteropCORBA.html
current/doc/doc-en/integrated/howto/InteropWebloIIOP.html
current/doc/doc-en/integrated/howto/InteropWebloWS.html
current/doc/doc-en/integrated/howto/J2EEWebServicesDevelopment.html
current/doc/doc-en/integrated/howto/JMSClustering.html
current/doc/doc-en/integrated/howto/JORAMdistributed.html
current/doc/doc-en/integrated/howto/JORAMdistributed_JOnAS_4_1.html
current/doc/doc-en/integrated/howto/JOnASEmbHowTo.html
current/doc/doc-en/integrated/howto/JOnASTransactionRecoveryHowTo.html
current/doc/doc-en/integrated/howto/JSR160_support.html
current/doc/doc-en/integrated/howto/JonasMBeansHowTo.html
current/doc/doc-en/integrated/howto/MC4J.html
current/doc/doc-en/integrated/howto/Migration.html
current/doc/doc-en/integrated/howto/MigrationNewWorldCruise.html
current/doc/doc-en/integrated/howto/WebServices_JOnAS_3_X.html
current/doc/doc-en/integrated/howto/WebSphereMQ.html
current/doc/doc-en/integrated/howto/Win32Service.html
current/doc/doc-en/integrated/howto/common.css
current/doc/doc-en/integrated/howto/howtoXdoclet.html
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current/doc/doc-en/integrated/howto/install_j2ee.html
current/doc/doc-en/integrated/howto/install_jonas.html
current/doc/doc-en/integrated/howto/install_juddi.html
current/doc/doc-en/integrated/howto/.DAV/
current/doc/doc-en/integrated/howto/clusterdetails/
current/doc/doc-en/integrated/howto/clusterdetails/AutomaticClusterConfiguration.html
current/doc/doc-en/integrated/howto/clusterdetails/ManualClusterConfiguration.html
current/doc/doc-en/integrated/howto/clusterdetails/c-jdbc.html
current/doc/doc-en/integrated/howto/clusterdetails/director.html
current/doc/doc-en/integrated/howto/clusterdetails/mod_jk2-to-mod_jk.html
current/doc/doc-en/integrated/howto/clusterdetails/mod_jk2_embeddedtomcat.html
current/doc/doc-en/integrated/howto/clusterdetails/mod_jk_embeddedtomcat.html
current/doc/doc-en/integrated/howto/clusterdetails/sequoia.html
current/doc/doc-en/integrated/howto/clusterdetails/.DAV/
current/doc/doc-en/integrated/howto/emb-images/
current/doc/doc-en/integrated/howto/emb-images/emb-component.png
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sent 11907775 bytes  received 10822 bytes  366726.06 bytes/sec
total size is 229315432  speedup is 19.24
building file list ... done
./
questionnaire1.cgi
vote.cgi

sent 2542 bytes  received 70 bytes  5224.00 bytes/sec
total size is 9002  speedup is 3.45

Files successfully copied to production Web server: http://jonas.objectweb.org/

1.6. Personnalisation de la doc JOnAS
Il y a trois niveaux de personnalisation possibles

1. personnalisation des transformations Docbook->autres formats (HTML ou XSL-FO)

L'idée est de fournir une couche de personnalisation (Customization layer) via une feuille de style .xls
qui permet de modifier certains paramétres comme la profondeur de la table des matières, la manière
de numéroter les chapitres, sections etc...

• pour une transformation DocBook->HTML les paramètres que l'on peut positionner sont décrits ici.
[http://docbook.sourceforge.net/release/xsl/current/doc/html/index.html]

• pour une transformation DocBook-> XSL-FO les paramètres positionnables sont décrits ici [http://
docbook.sourceforge.net/release/xsl/current/doc/fo/index.html].

• les feuilles de styles utilisées pour la doc JOnAS se trouve dans la dirictory resources et sont:

html.xls utilisée dans la génération d'un document monolitique

chunk.xls utilisée dans la génération d'un document segmenté. (elle aurait besoin d'améliora-
tion).

url(http://docbook.sourceforge.net/release/xsl/current/doc/html/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/html/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
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fo.xls utilisée dans la génération d'un document pdf

• pour trouver des renseignements sur les Customization layer se reporter au Chapter 8. Customization
methods du livre DocBook XSL: The Complete Guide - 3rd Edition [http://www.sagehill.net/doc-
bookxsl/CustomMethods.html]

2. personnalisation de la présentation des documents HTML

Il faut mieux éviter de positionner des caractéristiques de présentation dans le document DocBook lui
même mais plutôt de les positionner dans des Cascading Style Sheets (.css).

• On peut se reporter au chapitre Using CSS to style HTML [http://www.sagehill.net/docbookxsl/
UsingCSS.html] pour plus de renseignements

• Il y a deux feuilles de styles utilisées

resources/common.css Utilisée pour les documents html non intégré au site JOnAS

resources/wikifiles/style.css Utilisée pour les documents html intégré au site JOnAS

3. personnalisation de la présentation des documents pdf

Pour cette personnalisation il faut apprendre à connaitre le langage XSL-FO!

on peut se reporter:

• au tutoriel W3C Introduction to XSL-FO [http://www.w3schools.com/xslfo/xslfo_intro.asp]

• au FO Parameter Reference document [http://docbook.sourceforge.net/release/xsl/current/doc/fo/
index.html]

La feuille de style

resources/fo.xls permet d'élaborer une page de garde appropriée en fonction des bookinfo.
Elle pourrait permettre d'améliorer la présentation des document pdf actuel
mais il y a encore du travail à faire.

1.7. Problèmes en cours
La génération des chaines variables via la directive xi:include pose un problème quand cette chaine apparait
dans un lien

exemple :

<a href="#id2">abcde <span ><a name="appserver"></a>fghijk</span></a>

Le html généré par les feuilles de styles xls n'est pas valide voici le compte rendu du validateur html du
W3C:

Essai2 avec <span><a name="appserver"></a>JOnAS</span></a></span>

The element named above was found in a context where it is not allowed.
This could mean that you have incorrectly nested elements
-- such as a "style" element in the "body" section instead of inside "head" --
or two elements that overlap (which is not allowed).

One common cause for this error is the use of XHTML syntax in HTML documents.
Due to HTML's rules of implicitly closed elements, this error can create cascading effects.

url(http://www.sagehill.net/docbookxsl/CustomMethods.html)
url(http://www.sagehill.net/docbookxsl/CustomMethods.html)
url(http://www.sagehill.net/docbookxsl/CustomMethods.html)
url(http://www.sagehill.net/docbookxsl/CustomMethods.html)
url(http://www.sagehill.net/docbookxsl/UsingCSS.html)
url(http://www.sagehill.net/docbookxsl/UsingCSS.html)
url(http://www.sagehill.net/docbookxsl/UsingCSS.html)
url(http://www.w3schools.com/xslfo/xslfo_intro.asp)
url(http://www.w3schools.com/xslfo/xslfo_intro.asp)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
url(http://docbook.sourceforge.net/release/xsl/current/doc/fo/index.html)
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For instance, using XHTML's "self-closing" tags for "meta" and "link"
in the "head" section of a HTML document may cause the parser to infer the end of
the "head" section and the beginning of the "body" section
(where "link" and "meta" are not allowed; hence the reported error).

Le workaround utilisé est de procésser les fichier html générés et remplacer <a name="appserver"></a>
par rien (car par chance seule la string variable JOnAS apparit dans des href)
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Chapitre 2. L'outillage de
développement:XMlMind

2.1. Utiliser l'outil XMlMind (xxe)
via la command xxe

un manuel d'utilisateur en français se trouve ici  [file:///download/xxe/user_fr/index.html]

Dans notre environnement standard se trouve xmlMind 3.1.0 qui permet de faire des transformations doc-
Book -> html (en 1 ou plusieurs fichiers) via le menu DocBook> Convert document > Convert to HTML
[one page] cf Section 2.3.1, « Générer un html monolithique à partir du xml »

La conversion docBook -> pdf demande un addon supplementaire mais seuls des addons pour la version
xmlMind 3.5.1 sont accessible sur le site et dans la version xmlMind 3.5.1 les menus de conversion pré-
cédents n'existent que dans la version professionnelle...

2.2. Personnaliser son environement XMLmind
Pour pouvoir bénéficier d'un squelette de document nous préconisons d'utiliser un template spécifique
quand on veut écrire un nouveau book.

Ceci permet d'avoir pour chacun des livres une structure identique pour la partie bookinfo.

Pour personnaliser son environement xmlmind il faut:

• se créer une directory ~/.xxe/addon et y copier les deux fichiers suivants:

jonasbook.xxe:

<?xml version="1.0" encoding="UTF-8"?>
<configuration name="jonasbook"
xmlns="http://www.xmlmind.com/xmleditor/schema/configuration"
xmlns:cfg="http://www.xmlmind.com/xmleditor/schema/configuration"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.xmlmind.com/xmleditor/schema/configuration
../../../../addon/config/configuration/xsd/configuration.xsd">

<detect>
<dtdPublicId>-//XMLmind//DTD Example1//EN</dtdPublicId>
</detect>

<template name="JOnAS book" location="jonasbook.xml" />

</configuration>

jonasbook.xml:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE book PUBLIC "-//OASIS//DTD DocBook XML V4.4//EN"
"http://www.oasis-open.org/docbook/xml/4.4/docbookx.dtd">
<book>
<bookinfo>
<title></title>
<authorgroup>
<author>
<surname>Coq</surname>

<firstname>Philippe</firstname>

url(file:///download/xxe/user_fr/index.html)
url(file:///download/xxe/user_fr/index.html)
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</author>

<author>
<surname>Danes</surname>

<firstname>Adriana</firstname>
</author>

<corpauthor>JOnAS Team</corpauthor>
</authorgroup>

<copyright>
<year>2007</year>

<holder>ObjectWeb consortium</holder>
</copyright>

<abstract>
<para>This document ....</para>
</abstract>

<date>April 2007</date>
</bookinfo>

</book>

• positionner dans les options d'edit (Options>Options>Edit) le toggle XInclude.

Ces customisations permettent:

1. de bénéficier d'un template de book pour JOnAS quand on fait File > New...

2. de bénéficier des fonctionialites d'inclusion de tout ou partie de document.

2.3. Génération documents via XMLmind

2.3.1. Générer un html monolithique à partir du xml
• DocBook> Convert document > Convert to HTML [one page]

2.3.2. Générer en mode chunk
• Utiliser la commande

• convertdoc docb.toHTML configuration_guide.xml -u output

• Par défaut il y a un chunk par section de niveau 1 dans un chapitre. ils sont nommés :

• index.html

• ch01.html

• ch01s01.html

• Pour avoir le contrôle des noms de fichiers générés par l'outil positionner l'attribut id de la section
qui délimitera un chunk

• Si on veut un chunk pour les sections de niveau 1 et 2 il faut faire la commande suivante:

• convertdoc -p chunk.section.depth 2 docb.toHTML configuration_guide.xml -u output

• ils sont nommés:
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• index.html

• ch01.html

• ch01s01.html

• ch01s02.html

• ch01s02s01.html

• ...
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Chapitre 3. Apprendre à maitriser
DocBook

Il n'est pas dans mes intention d'écrire un manuel DocBook je vais indiquer quelques liens qui peuvent
être utiles.

Ensuite je voudrais aider à resoudre quelques problèmes plus ou moins communs

3.1. Quelques docs utiles sur DocBook
• DocBook XSL: The Complete Guide [http://www.sagehill.net/docbookxsl/index.html]

C'est la bible! un peu mastoc mais il faut y revenir régulièrement il est incontournable...

• DocBook: The Definitive Guide [http://docbook.org/tdg/en/html/docbook.html]

pas mal non plus on y trouve parfois des choses différentes que dans le précédent

• Manuel DocBook (en français) [http://feloy.free.fr/dbmanual/book1.html]

a le mérite d'être en français...

• DocBook-XML et éditeur XMLmind [www.mathrice.org/rencontres/mars.2007/presentations/Doc-
Book-Mathrice.pdf ] (en français)

excellente introduction rapide à DocBook (une sorte de DocBook pour les nuls...)

3.2. Quelques recettes de cuisines

3.2.1. Faire une documentation en Français
Comment faire pour qu'aprés transformation on obtienne dans une documentation française chapitre au
lieu de chapter, table des matières au lieu de table of contents etc...?

Il suffit de rajouter l'attribut lang="fr" dans l'élément book ainsi:

<book lang="fr">

3.2.2. Faire des liens
1. liens à l'interieur d'un document

il y a deux manières de faire:

• xref

il faut positionnner l'attribut linkend avec l'id de la section, chapitre,... ou on veut aller la chaine
sensible sera le titre de la section,chapitre,...

l'insertion d'un élément xref ne peut se faire via le menu.

exemple d'un lien xref vers une section ???

url(http://www.sagehill.net/docbookxsl/index.html)
url(http://www.sagehill.net/docbookxsl/index.html)
url(http://docbook.org/tdg/en/html/docbook.html)
url(http://docbook.org/tdg/en/html/docbook.html)
url(http://feloy.free.fr/dbmanual/book1.html)
url(http://feloy.free.fr/dbmanual/book1.html)
url(www.mathrice.org/rencontres/mars.2007/presentations/DocBook-Mathrice.pdf )
url(www.mathrice.org/rencontres/mars.2007/presentations/DocBook-Mathrice.pdf )
url(www.mathrice.org/rencontres/mars.2007/presentations/DocBook-Mathrice.pdf )
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• link

cet élément contient une chaine de caracteres qui deviendra sensible et un attribut linkend contenant
l'id de l'endoit ou on veut aller

l'insertion peut se faire en surlignant la chaine à rendre sensible et utiliser le menu a>link

exemple d'un lien link vers une partie de la section suivante  [23]

documentation plus complete ici [http://www.sagehill.net/docbookxsl/CrossRefs.html#IdrefLinks]

2. liens à l'exterieur d'un document

• ulink

l'insertion peut se faire en surlignant la chaine à rendre sensible et utiliser le menu a>ulink puis
position l'attribut url via l'editeur d'attribut

on peut l'utiliser pour faire un lien sur une url ou pour faire un lien sur une autre partie de la doc dont
on connait la position relative par rapport au document courant

exemple de lien vers objectweb [http://www.objectweb.org/]

exemple de lien vers le chapitre glossaire [Glossary.html]

• olink

est la manière de faire si on veut faire un lien vers une partie d'un autre document xml. la mise en
oeuvre est compliquée (voir ici [http://www.sagehill.net/docbookxsl/Olinking.html])

3.2.3. Faire un exemple commenté d'un fichier de conf
Pour obtenir ceci:

carol.protocols=jrmp                        1

carol.jrmp.url=rmi://localhost:1099         2

1 choice of the protocol or list of protocols
2 connexion url to the RMI registry

Il faut un <screen> (ou <programlisting>) avec des éléments <co> à l'endroit que l'on veut annoter avec
un identifiant comme attribut id

suivi d'un <calloutlist> ayant le meme nombre d'éléments <callout> que d'annotations, chacun des callou-
tayant un attribut arearefs contenant l'id de l'annotation correspondante.

Voici le code xml correspondant:

<para><screen>carol.protocols=jrmp                        <co id="id1" />
carol.jrmp.url=rmi://localhost:1099         <co id="id2" />
</screen><calloutlist>
<callout arearefs="id1">
<para>choice of the protocol or list of protocols</para>
</callout>

<callout arearefs="id2">
<para>connexion url to the RMI registry</para>
</callout>
</calloutlist></para>

A noter que l'insertion des annotations dans la ligne se fait trés simplement avec xxe.

url(http://www.sagehill.net/docbookxsl/CrossRefs.html#IdrefLinks)
url(http://www.sagehill.net/docbookxsl/CrossRefs.html#IdrefLinks)
url(http://www.objectweb.org/)
url(http://www.objectweb.org/)
url(Glossary.html)
url(Glossary.html)
url(http://www.sagehill.net/docbookxsl/Olinking.html)
url(http://www.sagehill.net/docbookxsl/Olinking.html)
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3.2.4. insérer des notes de bas de page
• inserer une nouvelle note :

• insérer un élément footnote

exemple : voici un exemple de note1

code correspondant:

<para>exemple : voici un exemple de note<footnote>
<para>première note de bas de page</para>
</footnote></para>

• insérer une note pointant sur une note existante:

• positionner l'attribut id de la note existante

• insérer un élément footnoteref l'attribut linkend a pour valeur l'attribut id de la note existante

exemple: voici une note1 référençant la précédente

code correspondant:

<para>exemple: voici une note<footnoteref linkend="firstnote" />
référençant la précédente</para>

3.2.5. Utiliser des chaines de caracteres variables
le fichier variables.xml est un fichier caché utilisé uniquement pour définir le contenu de chaines de
caractères qui risquent de changer (nom de projet, Numéro de version, etc...):

le fichier variables.xml est consitué d'une section et d'un ensemble de <para> ressemblant à: <para><phrase
id="objectweb">ObjectwebV2</phrase></para>

avec

• ObjectwebV2 étant la chaine à expanser

• id="objectweb" étant un identifiant introduit via l'éditeur d'attributs dans xxe

Le plus simple pour créer une nouvelle chaine est de copier insérer après un <para> existant et de modifier
la chaine et l'id (qui doit être unique dans le document.

Pour inserer une chaine dans un autre document xml :

1. cliquer sur la chaine voulue dans variable.xml

2. faire Edit>Document Reference>Copy as reference

3. faire paste a l'endroit voulu dans le document referencant

Pour produire le document html correspondant

1. se mettre sous le document referencant

2. faire DocBook> Convert Document >Convert to HTML

Si Convert to HTML -> génération dans directory out de index.html, html.css, ch01s01.html et de la
directoty images
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Si Convert to HTML [one page] -> génération a l'endroit voulu sous un nom voulu

Si Convert to HTML [one page, no TOC] -> idem que précédemment sans la TOC

3.2.6. Inclure un document xml dans un autre
cette manip est en partie manuelle. Sous xmlmind :

• s'assurer que dans les options d'edit (Options>Options>Edit) le toggle XInclude est positionné

• se mettre dans le document a référencer et clicker quelque part.

• faire Ctrl+Shift+C (Edit>Document Reference>Copy as reference )

• faire paste dans le document qui reference

sous eclipse ou emacs supprimer la partie xpointer="..." genere

3.2.7. Naviguer d'un document à l'autre
• pour modifier le document inclu :

cliquer sur une partie de celui-ci puis Edit > Document Reference> Edit Referenced Document

ou cliquer sur l'icone de droite que l'on voit ci-dessous

Figure 3.1. 

• pour revenir au document référençant :

cliquer sur l'icone de gauche de la figure ci-dessus (en haut à gauche de l'ecran)

ou faire Edit > Document Reference> Edit Referencing Document.

3.2.8. Zone apparaissant avec barre de défilement
Pour obtenir ceci une barre de défilement permettant de scroller une zone d'information importante :

la barre de défilement n'apparaitra que dans le document html, évidemment:

jonas check
JONAS_BASE set to /home/coqp/jb

- JONAS_ROOT value:
/home/coqp/JONAS_4_8_5

- JONAS_BASE value:
/home/coqp/JONAS_4_8_5

- JOnAS Services:
registry,jmx,jtm,db,dbm,security,resource,ejb,ws,web,ear

- Contents of 'jonas.properties':
jonas.service.security.realm.jndi.registration = false
jonas.service.db.user1 = jonas:jonas
jonas.service.mail.factories =
jonas.service.jtm.remote = false
jonas.service.jms.mom = org.objectweb.jonas_jms.JmsAdminForJoram
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jonas.service.ejb.auto-genic = true
jonas.service.resource.threadwaittimeout = 60
jonas.service.ejb.descriptors =
jonas.service.mail.class = org.objectweb.jonas.mail.MailServiceImpl
jonas.service.resource.resources =
jonas.service.web.descriptors =
jonas.service.ws.factory.class = org.objectweb.jonas.ws.axis.JAxisServiceFactory
jonas.security.manager = true
jonas.service.ws.wsdlhandlers = file1
jonas.service.ha.jgroups.conf = jgroups-ha.xml
jonas.service.registry.mode = collocated
jonas.service.dbm.datasources = HSQL1
jonas.service.resource.class = org.objectweb.jonas.resource.ResourceServiceImpl
jonas.service.security.class = org.objectweb.jonas.security.JonasSecurityServiceImpl
jonas.service.resource.parsingwithvalidation = true
jonas.service.discovery.class = org.objectweb.jonas.discovery.DiscoveryServiceImpl
jonas.service.ear.descriptors =
jonas.service.thread.class = org.objectweb.area.jonas.AreaService
jonas.service.resource.execworktimeout = 0
jonas.service.registry.class = org.objectweb.jonas.registry.RegistryServiceImpl
jonas.service.jms.queues = sampleQueue
jonas.service.discovery.multicast.address = 224.224.224.224
jonas.service.db.port = 9001
jonas.service.ejb.parsingwithvalidation = true
jonas.service.web.parsingwithvalidation = true
jonas.security.context.check.keystoreFile = /tmp/keystore
jonas.service.thread.ejbareaname = EJB
jonas.service.db.dbname = db_jonas
jonas.service.ejb.autoloaddir = autoload
jonas.service.jms.class = org.objectweb.jonas.jms.JmsServiceImpl
jonas.security.propagation = true
jonas.service.discovery.multicast.port = 9080
jonas.security.context.check = false
jonas.service.thread.file = jonas_areas.xml
jonas.service.discovery.ttl = 1
jonas.service.ha.datasource = jdbc_1
jonas.service.security.ws.realm = memrlm_1
jonas.service.ejb.minworkthreads = 3
jonas.service.dbm.class = org.objectweb.jonas.dbm.DataBaseServiceImpl
jonas.service.ws.wsgen.generator.factory = org.objectweb.jonas_ws.wsgen.generator.ews.EWSGeneratorFactory
jonas.service.ws.class = org.objectweb.jonas.ws.axis.AxisWSServiceImpl
jonas.service.resource.autoloaddir = autoload
jonas.service.jmx.class = org.objectweb.jonas.jmx.JmxServiceImpl
jonas.log.configfile = trace
jonas.service.ejb.maxworkthreads = 80
jonas.service.resource.minworkthreads = 5
jonas.service.web.autoloaddir = autoload
jonas.service.ha.timeout = 600
jonas.service.ha.gcl = jgroups
jonas.service.ear.parsingwithvalidation = true
jonas.service.ear.autoloaddir = autoload
jonas.service.resource.maxworkthreads = 80
jonas.service.ws.parsingwithvalidation = true
jonas.security.context.check.keystorePass = keystorepass
jonas.service.db.class = org.objectweb.jonas.db.hsqldb.HsqlDBServiceImpl
jonas.service.ear.class = org.objectweb.jonas.ear.EarServiceImpl
jonas.service.jtm.class = org.objectweb.jonas.jtm.TransactionServiceImpl
jonas.service.ha.class = org.objectweb.jonas.ha.HaServiceImpl
jonas.service.ejb.threadwaittimeout = 60
jonas.service.ha.jgroups.groupname = jonas-rep
jonas.csiv2.propagation = true
jonas.service.ejb.class = org.objectweb.jonas.container.EJBServiceImpl
jonas.service.jms.topics = sampleTopic
jonas.service.jtm.timeout = 60
jonas.service.jms.collocated = true
jonas.service.security.csiv2.realm = memrlm_1
jonas.service.web.class = org.objectweb.jonas.web.wrapper.catalina55.CatalinaJWebContainerServiceWrapper
jonas.security.context.check.alias = FB
jonas.service.discovery.source.port = 9888
jonas.services = registry,jmx,jtm,db,dbm,security,resource,ejb,ws,web,ear
jonas.transaction.propagation = true

- Check 'jonas-realm.xml':
File is present.

- Check 'JORAM configuration':
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Ok

The JOnAS environment seems correct.

Ce n'est pas un problème DocBook mais un problème de présentation qui peut être résolu via la feuille
de style.css

Ici je passe par un élément <programlisting> car dans l'html généré il apparaitra comme une classe pro-
gramlisting que l'on pourra customiser dans la feuille de style .css

• code DocBook associé:

<programlisting>
jonas check
JONAS_BASE set to /home/coqp/jb

- JONAS_ROOT value:
/home/coqp/JONAS_4_8_5

- JONAS_BASE value:
/home/coqp/JONAS_4_8_5
.....
.....
....
</programlisting>

• code html généré:

<pre class="programlisting">jonas check
JONAS_BASE set to /home/coqp/jb

- JONAS_ROOT value:
/home/coqp/JONAS_4_8_5

- JONAS_BASE value:
/home/coqp/JONAS_4_8_5

<pre class="programlisting">jonas check
JONAS_BASE set to /home/coqp/jb

- JONAS_ROOT value:
/home/coqp/JONAS_4_8_5

.....

.....

....

</pre>
</p>
</div>

• code css associé:

.programlisting {
overflow:auto;width:75%;height:200px;
border-top: 5px solid #FFFFFF;
border-bottom: 5px solid #FFFFFF;
border-color:black;
margin: 10px;
padding:5px;
}

Voici le résultat attendu (dans un document HTML):
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3.2.9. Générer un document pdf avec des bookmarks
Il suffit de rajouter dans dans la feuille de style fo.xsl:

<xsl:param name="fop1.extensions" select="1"/>
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Chapitre 4. Conventions et règles
diverses
4.1. Conventions et règles diverses

dans ce § un certain nombre de règles sont énumérées afin d'obtenir une documentation homogène:

• Eviter le style direct du genre

First of all, we need to define or you have to type the following command.

(sauf dans un tutorial)

• limiter les liens, utiliser l'inclusion

• Conventions typographiques pour les differents éléments textuels:

d'une manière générale la politique est de caracteriser l'élément textuel via un element DocBook ce qui
permettra de s'occupper de la présentation de cet élément de manière fine dans la feuille de style .css.

Donc, éviter emphasis et utiliser les éléments possibles de DocBook comme filename, classname,
property,etc...

dans xmlmind pour connaitre les éléments possibles surligner la chaine de caractères puis faire ctrl-T
(ou convert) le nom des éléments apparaissent dans la fenêtre à droite. A noter que certains élément
peuvent être encore précisé via l'éditeur d'attributs: à l'élément filename on peut préciser l'attribut class
avec les valeurs suivantes: directory, devicefile, extension,etc...

• nom de directory:

$JONAS_ROOT/conf

utiliser filename + attribut class=directory

• nom de fichier

jonas.properties

utiliser filename

• nom de propriete de configuration

jonas.services

utiliser property

• nom de variable d'environnement

JONAS_ROOT

utiliser envar

• valeur de variable d'environnement
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/home/jr48

dépend du type de la valeur , si c'est un path filename+directory si c'est une valeur prendre literal

• nom de classe java ou package :

javax.mail.internet.MimePartDataSource.

utiliser classname

• pour un ensemble de commandes ou le contenu d'un fichier utiliser l'élément screen.

exemples:

export JONAS_BASE=~/my_jonas_base
cd $JONAS_ROOT
ant create_jonasbase

# jonas rmi activation (jrmp, iiop, jeremie, or cmi) carol.protocols=jrmp
# RMI JRMP URL
carol.jrmp.url=rmi://localhost:1099

Voici un tableau permettant de controler le rendu pour les différents éléments textuels(compte tenu de
notre feuille de style utilisée) :

string elements/attributs rendu

logger.root.level aucun logger.root.level

logger.root.level emphasis logger.root.level

logger.root.level emphasis[bold] logger.root.level

logger.root.level filename logger.root.level

logger.root.level filename + class=directory logger.root.level

logger.root.level filename + class=extension logger.root.level

logger.root.level literal logger.root.level

logger.root.level classname logger.root.level

logger.root.level command logger.root.level

logger.root.level envar logger.root.level

logger.root.level interfacename logger.root.level

logger.root.level package logger.root.level

logger.root.level property logger.root.level

logger.root.level function logger.root.level

logger.root.level ulink logger.root.level [http://
wiki.jonas.objectweb.org]

voici la liste des éléments possibles [http://www.docbook.org/tdg/en/html/part2.html]

url(http://wiki.jonas.objectweb.org)
url(http://wiki.jonas.objectweb.org)
url(http://wiki.jonas.objectweb.org)
url(http://www.docbook.org/tdg/en/html/part2.html)
url(http://www.docbook.org/tdg/en/html/part2.html)
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